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Site Resources Help For Web Developers

This book is for Site construction, for web information, please see Web Design Guidline [1].

If you don't see the "term" in the instruction, you don't have permission to do that.

Target To Do For This Book

Setup by Admin
Permission for Architect, General Editor
How To
Style, CSS, Code
Permission role, node, type
Reports, Errors, Logs

  

Getting Started

The library's web site, web.library.yale.edu, is based on a Drupal content management system. Its Drupal instance,
called YaleSites [2], is run by Yale University ITS. Basic information is available at YaleSites [2].

Login 

To login go to http://web.library.yale.edu/cas [3] and use your netid and netid password. 
Once you've successfully logged in you will wee the black Administrator's toolbar at the top of your browser
window.

Navigation

The Administrator's toolbar allows you access to 

Dashboard: a central location with information about site content and recently updated files.
Content: this is where you go to create a page by selecting Add Content.
Structure: access menus and taxonomies.

  

Migrate Content to YaleSites

When you are ready to migrate web pages to YaleSites, decide

What you want to keep from your old site?
How do you want to display the information (see Create Home Page  [4]for more information)?
A point person to work with the User Experience group.

To Get Started
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Contact Steve Wieda <steven.wieda@yale.edu [5]>, and discuss the layout and content.
While User Experience designs the home site, you can start working with basic pages to migrate the
content.
Contact User Experience for anything that you can't do or don't know how to do.
You can switch to the new site after you have all old site content transferred, or you can redirect the old site
to the new one using the redirect function.

  

Create Home Page

There are several templates for libraries and departments:

Library Home, Arts [6], MSSA [7], Music [8], Divinity [9]: All have a different Heading, Main Menus, Search
block, Billboard Image, Menu, In focus news

Bass [10]; Uses the same Heading, adds Sub-section, and without In focus
Home page for International Collections [11], Classic Library [12] : Using "Collection Landing Page" to
provide menu and content"

East Asia Library [13], Fortunoff [14]: First Preference author block replaced by other content
Historical Sound Recordings [15]: moves content block to Third Preference area

Home page for Library IT [16], Microform [17]: have Default Heading and Main Menu
Preservation [18]: Add highlight menu block in Sub-section region
Giving to the Library [19]: Different heading

Home page for Digital Collections [20]: Different Theme

Templates and Regions

With different blocks put in different regions will create different home pages by using Context configuration.
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Custom Collection Landing Page for HSR

Create a Collection Landing Page > music/hsr

Structure > Context > international_collection > Add ~music/hsr to not using this context for the new pagae

Clone Contex > internationa_collection => historical_sound_recordings

Node type > Remove the Conditions for "Collection Landing Page"
Path > Give the path restriction to be "music/hsr"
Blocks > Preface Third

Remove "Field: field_find_link"
Add delta_blocks => "Page title"
Add system => "Main page content"
Add "Library Hour" block to top of this region after create the block with PHP Code

Structure > Blocks > Content > Configure the following
Page title => Add "~music/hsr" to not have this block show in Content Area
Main page content => Do the same step as above

Add the following iframe in the landing page to display library hour 

<iframe height="60" scrolling="no"
src="http://api.libcal.com/api_hours_today.php?iid=457&lid=400format=rss"></iframe>

OR can create a library hours block with PHP code, and style of "block-yul-hours highlight-block"

PHP Code
<?php

  $result = drupal_http_request('http://api.libcal.com/api_hours_today.php?iid=457&lid=405&format=html');
  $content = $result->data;
  print $content;

?>
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Sample Home Page : Giving to the Library

Disable Sitewide default title heading: Structure > Context > Scrolling down to "sitewide_default" > Edit >
Conditions: Path, exclude this site "~development*

Create new Context "giving_to_library" for this site

Create "giving_to_library_sub_site_name" block, with Block body:
"<h2 class="site-name"><a href="/development" title="Return to the Giving to the Library home
page">Giving to the Library</a></h2>" and CSS class "sub-site-name"
Clone "sitewide_default" context, do the necessary change

path: only "development*"
Blocks: Change Blocks in "Topper First" region from "Site name" to "YUL Workmark" and "Giving to
Library Sub-site Name".  All others are keep same with Side wide defaul.

Create proper menus and blocks as required
See more detail at "Create Development Council Site [21]".

  

Menu

Creatae Main Menu: Structure > Menus > Add Menu > Drag and drop to arrange the order
Create Menu block to using part of the Menu in Main menu by select propal parent menu

Main Menu => home page Main menu with level 1 title link
Research, Services, Libraries & Collections, Information & Policies (each one with it's own block) to
Menu Region, also "YUL Main Menu"
Places "Places Block" in "Sub-section" region, also as "Header" Menu

Manin menu Home => A revised menu For "Research Block" at "Preface First" Region
Yale Links => Home page footer menu

Top menu without page link:

Create a Menu with Custom Links it with URL as "javascript:voil(0)"

Expand Level 2 Keep level 1

Using default Menu block (was auto created when create new menu) instead of "Menu 2+"

References

https://wordpress.org/support/topic/no-page-menu-item [22]
http://wordpress.stackexchange.com/questions/30303/how-make-top-level-me... [23]

  

Custom Blocks

AddThis for facebook, twitter, email: create a block with CSS class "addthis" and Block body:
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<!-- AddThis Button BEGIN -->
<div class="addthis_toolbox addthis_floating_style addthis_16x16_style">
<a class="addthis_button_facebook_follow" addthis:userid="yalelibrary"></a>
<a class="addthis_button_twitter_follow" addthis:userid="yalelibrary"></a>
<a class="addthis_button_email"></a>
</div>
<script type="text/javascript">var addthis_config = {"data_track_addressbar":false};</script>
<script type="text/javascript"
src="//s7.addthis.com/js/300/addthis_widget.js#pubid=ra-5034cdc446677019"></script>
<!-- AddThis Button END -->

Arts Search Area Links => Point to "Arts main Menu - Search Area" with CSS class of "search-area-links narrow-or-
greater" to change the default search blocks at "Header First" Region

  

Using Library Theme - Testimonies Site

Need enable testimonies site to use library theme:

  sites > all > themes > yul > yul.info + add this line "allowed_sites[] = testimonies.library.yale.edu"

Request Library Theme deploy to testimonies site (contact ITS Massaro, Vincent <vincent.massaro@yale.edu 
[24]> and Pasko, Kimberly <kimberly.pasko@yale.edu [25]>)

"Yale University Library" Theme should appear in "Appearance > Settings", set it to default, and start to work from
here

Create 'YUL Wordmark' block

Machine name: yul_wordmark
Block Description: YUL Wordmark 
Block Body: <h2><a href="/" title="Yale University Library home page"><span class="yul-wordmark-
yale">Yale </span>University Library</a></h2>
 

Create 'Menu

References

YaleSite: Hiding your theme from other sites [26]

  

Fortunoff Home Page

Create 'Fortunoff Sub-site name' Block

Block description > 'Fortunoff Sub-site name'
Block body: <h2 class="site-name"><a href="/testimonies" title="Return to Yale University Library Fortunoff
Video Archive for Holocaust Testimonies">Fortunoff Video Archive for Holocaust Testimonies</a></h2> 
[Test format: Full HTML]

Page 5 of 34



Site Resources Help For Web Developers
Published on Yale University Library (https://web.library.yale.edu)

Block Title Link Setting > Display Link
 

Create Context "fortunoff_sub" for sub page > Tag: YUL >

Description : Header and footer, and other blocks, for path /testimonies*
Condition > Path > testimonies*
Blocks >

Topper First : "YUL Wordmark" ; "Fortunoff Sub-site name"
Topper Second : "Fortunoff Header"
Menu : "Fortunoff Research Nav" ; "Fortunoff Services Nav" ; "?Fortunoff Edit Program Nav" ;
"Fortunoff Visit Nav" ; "Fortunoff About Archive Nav" ;
Footer First: Footer
Footer Links : Yale Links

Create Context "fortunoff" for home page > Tag : YUL

Description :  Home Page for Fortunoff Video Archive for Holocaust Testimonies
Path : fortunoff => testimonies
Block >

Header First: YUL Orbis Search; YUL Finding Aids Search;
Header Second: View: Random Billboard: Fortunoff Block;
Preface First: Fortunoff Research Nav;
Preface Second: Foutunoff Quick Links Nav;
Preface Third: MSSA Hours;  Fortunoff Ask Block;

 
  

Redirect

Have the old and new URL ready. 

1. Backup the old file (to \\newton.its.yale.edu\libraryit-807001-ics\ue) or your choice.

2. Delete the old file (in ogma)

3. Do the redirect in one of the following way after login to web.library.yale.edu   
 

Configuration > Search and metadata > URL redirects > Add redirect
Put the old url path (other than http://www.library.yale.edu/ [27]) to top "From" box (with default of 
http://web.library.yale.edu/ [28])
Put the new URL to to bottom "To" box (full path, it will auto change to node/node-number in the
back ground, if you know the node number of the new page, you can put here directly)
 

Or just put the old url to browser to get "Page Not Found" message and click the rediret message (only if
you are login) "» Add URL redirect from this page to another location" to Add redirect screen, then do above
(the "From" box already filled in).
 
Or "Edit" the new page > go to "URL redirect" section at the bottom, click "Add URL redirect to this content 
[29]", the URL recirect screen will get (with "To" alredy filled as "node/node-number")
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Create Site Content

*Note: Library's templates and style are different from basic YaleSites.  If you can't do something according to the
instructions offered on YaleSites  [30], it's either because the library doesn't support that function yet, or you don't
have the necessary permissions to do that.  Don't be afraid of to ask.

  

Create Basic Page

Some functions that a basic page can do:

Heading Style:

What is the Personal Librarian Program?

The above title uses heading style "Heading 2." What you see in the edit box will be transformed, with the
original lower case changed to all upper case but with a font size half of the original.

How can I help you?

When using heading style with "Heading 3", there will be a blue line across the page under the title. 

Things I don't do (but I'll help you find out who can)

The next heading style of "Heading 4" will create a short line under title.
 

Other Heading

An example of "Heading 5." 

Smaller Heading size

And this the "Heading 6." 

Upload files / images

In Basic page, we can upload file/image by "Browse" to you local file/image, then click "Upload".  The file type limit
to certain format, check with web group for other file type.

you will see the file/image, right click the file name can give you the url for that file\image
default image location is "http://web.library.yale.edu/sites/default/files/content/images/filename.... [31],
default file location is "http://web.library.yale.edu/sites/default/files/files/filename.pdf.  [32]
We can also upload image from Body's tool bar, click "Image" icon > get "Image Properties" window

select "Upload" tag > Browse to local file, then "Send to Server"
back to "Image Info" Tag, the default URL will be "sites/default/files/images/filename.jpg",
you can set "Alternate Text" and image size here.

References:

YaleSites The WYSIWYG toolbar [33]
YaleSites Working with Content [34]
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Create a Book : "Site Resource Help" Sample

Create new book

Content > Add Content > Book page
Title:  Book Title 
Body: Content for book cover page
Sub-section: Library information Technology
URL path setting: Generate automatic URL alias => lit/sr/create-a-book
Book Outline: Select "Create a new Book"
Publishing option: Published (or else won't show up in book menu)
Have Administrator "Enable the book": Structure > Context > Book Navigation > Book, Check the book
"Site Resources Help"
Add new Child page by "Add Child Page" button at any book page, or Content > Add Book Page > Select
the book at "Book outline" 

Adjustment, Tips

The default book page url is [node:book:parents:join-path]/[node:title] => site-resources-help/create-a-book
Select Sub-section only if you want the sub-section title show on all book page
In order to not have default LIT Sidebar First menu show up in the book pages, have to revise Context >
library-it > Path > add ~/lit/sr*
To put the page as child page of the book's first Child page, select that child page at Book Outline
Example: Site Resources Help -- Create Home Page for "Sample Home Page for Giving to the Library"
To Change page order: Content > Books > click "Edit order and titles" or change "Weight" number in Book
Outline, smaller number will be on top
If change the url alis, and the page is new, delete the redirect after save the change to avoid possible loop
error
Basic page can also be in the book by adding the Book in Book Outline
Tip: Add (Draft) for not complete page, but don't put -draft at url, so can take off after finish the content to
avoid url change

Update

Add More fields for task, Apps Type content (12/9/16)
Contact - Person in Charge
Main Information - More detail link to main source

Create book "Library IT Tasks, Apps Support" with default url "/lit/supports/[node:title]". Add ~/lit/supports*"
to library-it Context > Path (12/9/16 on test server)

  

Create Development Council Site

Create Development Main Menu
Create Development Council Menu
Create giving_to_library_sub_site_name block

Machine name

Block description
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Block Body

CSS classes(es)

Go to sitewide_default context > add "~development*" to not use default header and footer
Create giving_to_library Context
Name giving_to_library
Tag YUL
Description Giving to the Library Home and sub page
Conditions Path: development*
Topper First YUL Wordmark; Giving to Library Sub-site Name
Topper Second Header; AddThis
Menu Research Block Nav; Services Block Nav; Libraries

and Collections Block Nav; Information and Policies
Block Nav

Sidebar First Development Main Menu
Footer First Footer
Footer Third Yale Links

Create Development Council Content Type, with additional fields for "Member Image" and Photo
Description", set these two fields "Enable" using CCk blocks and hidden in "Manage Display" field
Create "development_council" context:

Path "development/yul_council"
Blocks > Content: "Field: field_title" ; "Field: body"
Blocks > Sidebar Second: "Field: field_council_member_image" ; "Field:
field_council_photo_description"

Later, put above two fields (CCK block) directly to "Sidebar Second", the development_council" context no
more needed.

  

Create a Digital Collection Highlight Page

When a digital collection is created or migrated to the D [35]igital Collections System [36] (DCS) interface a digital
collection page should be created. This page describes the collection.

Example pages:

Persian Medical Books [37]
Day Missions [38]

Steps

Login to the web site http://web.library.yale.edu/cas [3]
Create a new page of Content Type=Collection Highlight
Give the collection a title, which must match the name you've used when you created the collection in
Ladybird.
Upload a high quality image. You may use more than one image.
Note that for accessibility you MUST give Alternative text for the image. Make it descriptive, naming things
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in the image, or what is depicted by it. This should be different than the offical title of the image.
For Digital Library URL in DCS, you will use the faceted digital collection link. First you must take that URL
and convert to a more manageable URL with a service such as Bitly or TinyURL. Otherwise, the link will
break.
Give a full description covering interesting points about the collection.
Enter the names of any funders for the collection by choosing from the drop down list under Funding
Source. If your funder is not listed an entry must be created first. Contact the Development Office for the
official name of the funder, and then speak with User Experience staff to have the entry made. 
Fill in other fields as desired.
Switch Theme Key to YUL Digital.
You must enter under Related Resources the YUL Terms of
Use, http://guides.library.yale.edu/content.php?pid=445257&sid=4406775#16108285 [39]
Change to a created URL, which should follow this standard library.yale.edu/digitial-collections/[collection-
name-use hyphens-no-spaces]
Three fields help to determine how the collection will display on the Digital Collections page.

New collections will usually be in Findit, so that radio button should be selected. 
Promoted only applies to collections not in Findit. For Findit collections ignore this field (leave as
NO).
Featured. Select this field if you would like your collection to show in the rotating images. You must
have a good quality image associated with the collection. 

Remember to save your work.
When you are ready, Publish the page. 

  

Funders

The library acknowledges funders of digital collections using the Digital Collection Highlight pages. There is a
taxonomy of funders.

Acknowledge a Funder (for Collection Owner)

Create a Digital Collection Highlight page, and in the Funder field select the appropriate funder from the pull
down list.
If the funder is not on the list:

Contact the Yale University Library Development Office and ask for the correct, formal name of the
funder.
Send the funder's name and description to the User Experience Department. Include a URL for the
organization. 
The UX department will create the page and add the funder to the taxonomy. In the Digital
Collection Highlight page add the funder.

When the Digital Collection Highlight page is published check to see that the funder is listed, the link to the
funder works, and this digital collection is listed on the funder page.

Create the Funder Entry (for UX staff)

Make sure the funder name has been approved and that an entry does not already exist.
On the web site go to Structure>Taxonomy>Funding Source>Add Term
Create the page and notify the collection owner. The associated digital collection will not be listed with the
funder until the Digital Collection Highlight page is created and published.

 
  

Webform

Setup
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Setup permission (one time setup): People > Permission > Node > enable "General Editor" to "Webform:
Edit own content"
Currently, general editor won't be able to create webform in Product environment. Get title from request,
create a webform with that title. The default path will be "form/title-in-lower-case"
Select proper "Sub-section" if require
Change author to the person who is going to edit the form.
The owner can start to work with the form now.

Try webform

For Practice: Log in to dev.library.yale.edu
Conatent > Add Content > Webform
Give the "Title" and write the description for this form in "Body", that will show up on the top of form. Save
the form.
Additional tags show after the form been created

Edit
Webform

Form components
Conditionals
E-mails
Form Settings

References

YaleSites: Create a New Webform [40]

  

Custom Email Subject 

"Text [submission:values:field_set_key:field_key:nolabel] More text"
** nolabel is an optional, indicate "Do not show Label"
=> Purchase Request - [submission:values:item_information:item_title:nolabel]

References:

Drupal: How to customize the subject field with form component values [41]
Bohemian Blog: Drupal Webform Module: How To Customize the Subject Line
Drupal Upgrading from Webform 3.x to 4.x [42]

  

Webform Tips

There are several futures that can help to get the information. The best place to get token source is click "Browse
available Tokens". Here are some examples.

Q: By default, Yale user can log into Drupal with their netid, Drupal will create an account with some basic from
Yale Directory, so if a user log into a form, we can get user's information as default value with the following token:

[current-user:name] for Current login user's name
[current-user:mail] for E-mail
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Create News

There are two different News Sources

Create in Drupal: Content > Add Content > News
Summary: For "In Focus" short description
Image also for "In Focus" (Suggest the size of 120x90 to 500x500 pisels)
Sub-section: to set which department the news will show

Feed from other source through feed function: Content > Add Content > News Feed => Fill in the URL of
the external News Feed

The default News Importer import the following information: Title, Description (to Body), Published
date, Item URL (to External link), Categories (to Feed Category), Sub-section (for different home
page)
In Focus Admin > select the news that will show to Home page (need to add "Image" and
"Summary" fields)

The default url for "News" Content Type is news/yyyy/mm/news-title

There are two major views

Structure > Views > In Focus > as "Home Page" In Focus area
Structure > Views > News > News page, News Block to display only a short description about the news.

For Library News, there are more settings, see "Library News [43]"

  

Custom Fields in YUL Site

Code Fields

Dynamic Fields (Entities: Comment, Field collection item, Node, Taxonomy term, User, Rules config)

Committee Membership ( sd/staff/* ): Views > Library Committees> Content pane: membership
Dynamic Unit Staff CP ( sd/dept/* )
Subject Librarian from Collection Development Statements ( sd/staff/* )

Block fields

Building Places Block (Buildings)
ShareThis (Home Page)

Preprocess Fields

 
  

Github Connection

** Library site is on Acquia Cloud now, no more many of the following functions, see Starting with an Acquia Cloud 
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[44] site instead.

New Member First Time Connection

Install Git for Window [45]. Open Git Shell, Identify yourself to Git
> git config --global user.name 'Your Name'
> git config --global user.email you@ [46]yale.edu

Log in to GitHub: Enterprise using Yale netID [47]
Give Admin your netid to add you into the desire repository (example: yul/dev.library.yale.edu)
Log in to GitHub, Go to yul/dev.library.yale.edu > Click "Fork" to (@netid) to create your own repository
=> netid/dev.library.yale.edu
Go to the new created repository, clone HTTPS URL (Click copy to clickboard icon)
=> https://git.yale.edu/ [47]netid/dev.library.yale.edu.git
Open Git Shell on your desktop, do the following

> git clone https://git.yale.edu/ [47]netid/dev.library.yale.edu.git c:\drupal\dev.library.yale.edu (create
local copy at your local location)
> cd /
> cd drupal/dev.library.yale.edu
> git remote -v  (you should get: 
origin https://git.yale.edu/netid/dev.library.yale.edu.git [48](fetch)
origin https://git.yale.edu/netid/dev.library.yale.edu.git [48](push)
> git remote add upstream https://git.yale.edu/yul/dev.library.yale.edu.git [49]
> git remote -v should get "origin" and "upstream" information for "fetch" and "push"

Start work on your local copy

Update:

Syncing a fork
> git fetch upstream (get update code from yul/dev.library.yale.edu)
> git checkout master (you might already in master and don't need this step)
> git merge upstream/master  (merge the new update to your local copy)
> git push origin master (sync the change in yul/dev.library.yale.edu from your local to
netid\dev.library.yale.edu fork)

Change in yul/dev.library.yale.edu will be able see in http://dev.library.yale.edu [50]
** Current default is mteac/dev.library.yale.edu if yul/dev.library.yale.edu doesn't work
Can make change directly on yul/dev.library.yale.edu 
To get the change to product site, do "Pull Requests" from yul/dev.library.yale.edu to drupal/d7, the change
will be monitor by ITS, and deploy in Tuesday or Thursday night
To get the product environment to dev, do refresh request from http://yalesites.yale.edu/refresh-my-site 
[51]. (Notice other users about the refresh for them to save their works.)

One time Setup

Fork from drupal/d7 to yul => yul/dev.library.yale.edu
Add Jenkins
To create yul/dev.testimonies.yale.edu following the instruction "Forking multiple times" in the following
reference "YaleSites Using GitHub Enterprise"
Create organization > "yul"

Add Members (mteac, kb89)
Create New Team > "testimonies" (Developers for Testimonies site) > Admin Access (The user
must first log in with NetID to create account before add them to the team)

Add member
Add repository

References:

YaleSites Using Github Enterprise [52]
YaleSites Getting changes merged upstream [53]
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YaleSites Common Git Operations [54]
GitHub Set Up Git [55]
GitHub Create A Repository [56]
GitHub Fork A Repo [57]
Drupal Installing Drush on Windows [58]

  

How To

Tips, Admin How to, Quick Fix

Useful quick tools

Configuration > Search and Metadata > URL aliases > Patterns
Configuration > Development > Site Backup
Request DEV site refresh from PROD sit at http://yalesites.yale.edu/refresh-my-site [51]
Structure > Context > book_navigation
Configuration > People > CAS Settings > Redirection

  

Home Page Updates

Emergency Block

Activate Emergency Block

1. Login at http://services.library.yale.edu/cas [59]
2. Click on "Structure"
3. Click on "Blocks"
4. The Emergency Block should be under "Disabled".  Click on "configure" for the Emergency Block
5. Update the text in the block body with the latest message
6. Click on "Save block" at the bottom of the page
7. Find View: Random Banner under Header Second.  Change its region to "- None -"
8. Find the Emergency Block under "Disabled".  Change its region to "Header Second"
9. Click "Save Blocks" at the bottom of the page

Turn Off Emergency Block

1. Login at http://services.library.yale.edu/cas [59]
2. Click on "Structure"
3. Click on "Blocks"
4. The Emergency Block should be under "Header Second".  Change the Region for the Emergency Block to

"- None -"
5. Find the View: Random Banner under "Disabled".  Change its Region to "Header Second"
6. Click "Save Blocks" at the Bottom of the page

  

Working with Images

Before working in Drupal, you can use a simple editor to resize an image. Staff can edit pictures using Microsoft
Office 2010. Use Edit Pictures > "Resize" or "Crop." If you resize you should maintain the aspect ratio.
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Sizes in Use

Billboard Image must be larger than 650x217 pixes
People Picture style: people_thumbnail. Upload dimension 1600x1200 (1024KB)

Change Sizes

Create a style to set the image size in Configuration > Media > Image Styles

The "Thumbnail (100x100)" will change 800(w)x 600(h) image to 100x75
The "square_thumbnail" will change 800x600 image "Scale and Crop" to 48x48
The "people_thumbnail_small" is 60x90
For "PL Photo Size" do Scale and crop 240x180 and the Resize 210x155
Square 60x60 for PL home page and PL Search Page "Browse all PL"

References

YaleSites Rotating Header Image [60]
YaleSites Add embedded images [61]

  

CAS Access

To require CAS login to access a page use Configuration > People > CAS Settings > Redirection > Add the url to
"Specific pages"
http://web.library.yale.edu/admin/config/people/cas [62]
 

These pages allow access after CAS login only. (as of 3/29/2017)

fuser
pls
ecollections/catalog-only-resource-request
ecollections/acquisitions-resource-request
form/recommend-book
research-education/course-related-instruction-request
research-education/research-consultation-request
book-request/purchase-request
form/purchase-request
form/project-proposal
form/sterling-memorial-library-event-reservations
borrowing/west-campus-delivery-service
mssa/senior-essay-prize-form
form/diane-kaplan-memorial-senior-essay-prize-intention-form
bass/reservation-form
lit/wts/report-problem
lit/wts/service-request
sml/event-reservations
form/library-it-project-proposal
form/library-project-proposal-form
[submission:url]
access-american-wind-energy-association-awea
access-audio-digest
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azure-access
access-bookseller
access-cinefex
access-database-biographical-materials-ching-historical-figures
access-ductus
access-environmental-finance
access-ethvest
access-global-financial-data
access-grand-secretariat-archives
access-guidestar-premium-0
HBW
access-hand-papermaking-newsletter
access-homepower
marketplace
access-mergent-moody-corporate-manuals
access-mergent-webreports
access-metacore
access-narc
access-narcasrc-online-archive
access-nasm-directory
access-national-palace-museum-database-ching-palace-memorials
access-opera-news
access-passport
access-preqin
access-pymca
access-roshan-cultural-heritage-films
access-snl-energy
access-staatsalmanak
access-symptom-media
access-tablet
access-times-literary-supplement
access-tls-archive
access-world-today
access-zig
form/orbis-heading-change-request
form/report-defect
departments/e-resources/ip
form/library-computer-purchase-request-form
form/cataloging-online-resource-request-form
form/acquisitions-online-resource-order-request-form 

  

Link In Focus: Sample for Arts

Redirect Arts News Archive page from arts/news to news/arts-area (Global News View Setting)

Create Menu "Arts In Focus" => auto create block "Arts In Focus" > Edit

link title "News Archive
path arts/news

Go to "Arts In Focus" block, set "Title" => <none>, only appear in "arts", Move to "Content" Refion, seat under "In
Focus" block

From https://git.yale.edu/mteac/tst.library.yale.edu/blob/master/sites/all/th... [63]
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Copy>
/* ---------------------------------------------------------------- in focus */

.view-in-focus .views-row {
  float: left;
  clear: none;
  margin-right: 0;
  margin-bottom: 0;
}

#block-menu-menu-in-focus {
  position: absolute;
  top: 4px;
}

#block-menu-menu-in-focus a {
  color: #0F4D92;
}

#block-menu-menu-in-focus a:hover {
  color: #F9BE00;
}

Edit (Add) with
#block-menu-menu-in-focus-arts {
  position: absolute;
  top: -6px;
}
 
#block-menu-menu-in-focus a,
#block-menu-menu-in-focus-arts a {
  color: #0F4D92;
}
 
#block-menu-menu-in-focus a:hover,
#block-menu-menu-in-focus-arts a:hover {
  color: #F9BE00;
}

 

  

CSS: Color and Style

Block Styles

narrow-or-greater (Enable to block the display when the screen width become narrow)
highlight-block

Color Code

Yale Blue 0F4D92 Haas Orange F48734

 FCE188 Parchment FEF4D4

Pencil F9BE00  61262A

 D9E9F2 Business Site Medium Blue 708FB9

Higher Intensity Blue 026CB6  527D73
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Click on the image for a larger version:

[64] 

  

Add Search Function

Add in Code

   Sites > All > Modules > Custom > yul_search > yul_search.module

1. In function yul_search_block_info() > add one block line information
2. In function yul_search_view($delta = '') > add new case
3. Add function yul_(***)_search_block_content()
4. In function yul_search_forms() > Add $forms[**] = array(......
5. Add function yul_(***)_search_box($form, $form_state, $form_id)
6. Add function yul_(***)_search_box_form_submit($form, &$form_state)

Create in View

Create a searh view page that will display the search result with "Filter Criteria"
Advance > Exposed Form > Exposed form in block "yes" => search block will created
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Header First Menu

MSSA Add New link to Research menu: Structure > Menus > MSSA Min Menu  > Add link
"Using Special Collections at Yale" under -- Research,
=> Link will show up both Research Block and Research Dropdown  The default space need to add more height 

in Firefox compare smaller font size (in IE) 

If need add the height:

Site > All > themes > yul > css > yul-yul-default.css
   Find .context-mssa #zone-menu .research-block-nav .cont to change height

  .context-mssa #zone-menu .research-block-nav .content {
  height: 175px;
  }

   Do the same change for yul-yul-default-narrow.css and yul-yul-default-normal.css

 

  

Update Current Setting

Enable Drupal functions
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Add Yale People list Module => Add "staff" selection in user profile
Enable "Flex Slide?" => PL slide view

  

Library News

Maintain and Update

"This Week at the Library [65]" needs to be update every Monday with new page's URL

** Needs to find way to auto update the archives annually

Create new News

Content > Add New Content > News > Fill in Title

Summary is for content that will appear on Home page's "In Focus"
Upload Image (with size of ratio width : height = 3:4) for "In Focus"
Body for the detail about the news
Set Event Time Starting date (default is the created date) and Ending Date (default is 3 months from
created date) if there are different
Set Feed Category to "Library News"
Set Sub-section to "Yale University Library News"
Set External link same as this news' url (currently needed for "Share to Facebook") which is
news/year/month/news-title
Publish and Stick to front (if going to show on Home page "In Focus")

Migrate old News

Copy and Past from old Library News Archives for monthly news and annual title lists between May
2008-December 2014 in Basic page with following pattern:

December 2008 [66] (librarynews/archives/2008/12) => all news content created in the month of December
2008
2009 Archives [67] (librarynews/archives/2009) => all news title lists for year of 2009
Update the link in each page
** Needs to update the external link for month of Jan and Feb 2015 to keep unique format for future
Archives View Setting

Settings > Views > In Focus > Home > Fields > Content: Title >

Was: Output this field as a link from external link [field_link_to_external_story] through news feed disable in
March 2015) from ogma
Change to: Link this field to the original piece of content (Start in March 2015)
 

Archives View Setup

Select Month to show Title list of the month.
Library News Archives > "August 2014 (10)" has all news published on that Month. These are news posted
in the current academic year.
Archives before Aug 2014 had Archives pages from old server, doesn't dynamic created from Drupal
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Structres > Views > Librarynews

References

Library News [68] 

  

Nota Bene

When a new issue of Nota Bene is released, it must be submitted to EliScholar. Once it is sent to EliScholar and
published, an entry can be added to the web site.

Upload File to EliScholar

Get Cover image, resize to ~150x190 

Create a News Item for Nota Bene

The news should import within one hour, for quick import, you can "Pull Nota Bene Import (Content > type: News
Feed > Nota Bene Feed) > http://web.library.yale.edu/nota-bene-feed [69] > Import > Import "**
** Not everyone can do these steps. You must have Admin access to the web site.

Get the imported new issues (Content > type: News, not published )
=> news title will be something like this: "Nota Bene: News from the Yale Library, Annual Report Issue, fall 2014" >
Edit 

Add text in "Summary", this will show at Library Home page if intent to publish to there.
Click Body (Edit Summary) => Text that will show under the image for / [70]yul-publication [70]s page.
Nota Bene
Spring 2016
HTML will add <p> tag for the text indent.
Image > Upload the image 
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Feed Category > Nota Bene  
+ hold shift to add "Library News", if the same content will be published in Library News
Also make sure Sub-section is "Yale University Library News" if going to publish as Library News
External link > should already exist (if original document moved to other area, than change it here) 

** If prefer link directory to the downloadable pdf file, check from Elischolar to get the url and replace it here
with http://elischolar.library.yale.edu/cgi/viewcontent.cgi?article=1075&context=yul_nota_bene [71] (for Fall
2016 issue)
 
Publish this news

**It is good practice to un-publish the older issues unless the news is going to keep for News Archives.

  

Personal Librarian

Update Setup for Yale College PL Program

Add New Personal Librarian: 

Make sure PL name already in Drupal, check at web.library.yale.edu/users [72], click edit, go to the bottom
"Admin Field", make sure PL has "general editor" role.
Add New PL Page: Content > Add Content > Personal Librarian
** The PL Page Tile use Profile's Name area - the official name, which can be changed only by web user
administer.
** The url for PL page using Page title with string transform to lower case and add hyphen for space
For Divinity School PL, Change "Sub-section" from "Yale College Personal Librarian Program" to "Divinity
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Library"
Go to bottom, open "Authoring Information", change "Authored by" from your name to the new PL's name
(type in first couple letters of PL's name, will auto show name list to pickup)
Change "Publishing options" to "published"
Save
Have the new PL update the new PL page (PL Message, Related Information for more links) , also update
information on personal profile follow the instruction at here [73]

Add New Student

Content > Add Content > Add New Content Type "Yale College PL Program"
Fill in the following fields: Title (with Netid), Student Name, Class Year, Personal Librarian (should show
name list after type in first few letters), Email and Phone
To update information individually, go to "Admin PL Students [74]" > Search by student netid > Click "Edit"
to update

Setup and Configuration

Import Student-Personal spreadsheet

At the beginning of each Fall, get a new update file.  Prepare spread sheet with the following column name:
NetID, Name, Class, Librarian, Email, Phone, where the Email is Librarian's Email. 
For Divinity, the columns are: netid, email, name, class, pl, where email is student's email.
**Make sure no duplicate Netid (in spreadsheet, highlight Netid column, go to Home > Conditional
Formatting > Highlight Cells Rules > Duplicate Values)
**Make sure no special characters (ó é è ã ö í ä á ñ Å ? ç ú ü Ö ) in fields, use the formula {
=IF(ISNUMBER(SEARCH(I$1,$A2)),"v","") } (where A is Name Column, I$1 is one of the diacritic locate
cell) to check. --- Don't need this after enable UTF-8 support enable.
**When do copy and Paste, make sure no blank space before or after "Name, Email" fields
**Make sure using the name in name field for Personal Librarians (in Drupal Profile - Refer to the PL name
list at /pl home page)
Open the spreadsheet (the one to be upload) and save as *.csv file (Click OK if has multiple sheets in file,
then click No to not save the file formate, click cancel to not save, the first step already create a *.csv)
Structure > Feeds importer > PL Students Upload (or Divinity Student PL) >

Make sure at Node processor > Settings => check the followings, and "SAVE" the change.
Insert new nodes
Replace existing nodes
Delete non-existent nodes

* When just want to do part of the update, just save part of that data, change above "Delete non-
existing nodes" to "Skip non-existent node"
Back to "Feeds importers"  (Click the link on top in breadcrumbs)

Click "import" link at top of the text
Select "PL Students Upload"
Click "Choose File", browse to saved *.csv File
Click > "Import"

Revise Personal Librarian Program Home Page

Remove PL

To remove PL, just unpublished that PL's PL page or delete it.

References

Drupal: How to change stacking order for mobile layouts [75]
Personal Librarian Help [73]
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Subject Specialist 

Maintain and Update

Check Taxonomy Subjects Terms each semester / Year with the Yale resources (see references below)
Update Subject Specialist associate with each subject term

For Librarians in Subject Guides contacts Katie Bauer [76]
For Librarians by Major contacts Emily Horning [77]
For Librarians by Programs and Departments contacts Melanie Maksin [78]

Several Changes need to do or possible to do
Thin border around image
Set the subjects that don't have libguid page to "Ask Yale Library"?
Subjects not in Major or Program or Libguide for special case of in Instruction, the parent <-> sub-
subject relation?

Setup

Create Taxonomy: Subjects

Import terms from Library Subject Guides, Majors in Yale College, Programs & Departments
Add Category field to distinguish the subject resources from above 3 resources
Add field for subject Specialist
Add field in user account setting for Subject Librarian alternate home page (Group user that doesn't have
libguidID)

Create view to get the Librarians by Major (Librarians for Undergraduates [79])

Create another view to get the Librarians by Programs & Departments (Librarians for Graduate Students and
Faculty [80])

Create a main page that can search the librarian by any subject word(s) in Taxonomy Subjects (from Subject
Guides, Majors, or Programs & Departments) by enable "Exposed Form in Block" and put this block in "Sidebar
First" region on "Find a Subject Specialist  [81]" main page => Later also put into the basic page as main page
(/subject-specialists, change the search page to /sl) in order to have blank search boxes for "Subject" and
"Librarian" (add as OR function)

The common notes is from block that is set in Content Region between "Page Title" and "Page Main Content" for
the 3 mentioned pages.  Later do the revise, the search page had the instruction (at footer area - so the search
result will be on top of it) same as basic page (didn't use block, so when do update, need change both places)

Create a view block that rotate the Subject Specialist name and photo in Main Page's Sidebar First region both
image and name are link to libguid page by feed back, original name was link to email).

** Due to Libguides updatae, need change the following url setting: Views > Subject Taxonomy > User Libguide id
> Rewrite Results > Link path (http://guides.library.yale.edu/profile.php?uid=[field_user_libguid_id]) =>
(http://guides.library.yale.edu/prf.php?account_id=[field_user_libguid_id])

References

Yale Factsheet [82]
Library Subject Guides [83]
Majors and Academic Programs [84]
Majors in Yale College [85]
Yale Graduate School of Arts and Sciences Programs & Departments [86]
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Subjects of Instruction [87]
Subject Abbreviations [88]

  

Staff Directory Setup

Set up New YUL Staff (* are required field)

People > Add CAS user > type in new staff netid (one line per person) > Create new account(s)
Will create new user profile if the staff doesn't have account in library's web site (or "Already exit in
the system")
Click user profile link to edit user's information (try to not use special diacritic for easy search)

*Full Name: will be Display name at User page
Phone number
Building
Office Location
*Last name
* First name : this with Last name will be used for YUL Staff Page Title
Unit: will be the main default department or sub-department (if stuff under some sub-
department, its department name will auto get from view), this is only for reference, may not
update if people change unit) 
**Save

Content > Add Content > YUL Staff
Name: Don't fill in, it will be get the value from above user profile, show here only for peopel
change name after this page created.
*YUL Staff Title
*Unit: get staff's sub-department (unit) name, department name will auto get from Department
Directory Content Type, update here if person change unit.
Position: default to "5", do necessary change if need display on the top of staff list
*Building
Office Location
* Go to "Authoring information" > Change "Author by" from your name to the new staff's name (start
to type first name will auto create name list for you to pick up)
* Save => should have the name fill in now 

Check department directory (http://web.library.yale.edu/sd/departments [89]) to see if the staff show up
there

When Staff leaves

Go to User's Page > Delete related fields (use http://web.library.yale.edu/users [90] to search the person
and edit)
Go to YUL Staff's page > Delete the page (use http://web.library.yale.edu/admin/yul-staff [91] to find the
YUL Staff page)

New Department or sub-department not in the list

Content > Add Content > YUL Department Directory
*Title: Department or Sub-Department name
*Web Site: Give the same name as "Title"
URL: fill in if there is one
Left Contact, Center Contact, Right Contact: are for information that will be on Department Directory
information section
Sub-Department: fill in only if the Title is a department and has sub-department
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Department: only fill in if the Title is a sub-department, then fill in it's department name
Default URL will be sd/dept/department-name, if prefer alias, should use se/dept/alias
*Save

When Staff change information, just do the necessary change in either user profile (phone, name) or YUL Staff
Profile ( name, title, unit, building, location).

New Building not in the list or need to do title change: Contact Steve Wieda [92]

Create new building for all other information
"YUL Staff Building Location" field in the Building Content Type is the name used for Staff Directory

 
  

Accessibility

At Yale University and the library we strive to follow the AA standards of the W3C Web Content Accessibility
Guidelines (WCAG) 2.0. [93] Making your web site accessible means your online resource is usable by the widest
variety of people possible, including those who use screen readers, cannot use a mouse, or who may be on a slow
wireless connection. The User Experience group recommends library web site and subject guide creators review
the guidelines listed here so that you understand the major components of web accessibility. Following basic
accessibility guidelines will ensure that your web site is coded accurately for meaning and that it will be rendered
well in a variety of formats. 

When you create an individual web site or subject guide you use tools (Yale's Drupal service and Libguides), which
when used correctly will produce highly accessible pages. Simply using the color schemes defined in the library's
YaleSites and Libguides implementation, and following the system prompts when creating pages and forms will
ensure a high-level of accessibility. You can use the simple checklist provided here to ensure that you have not
introduced any inaccessible elements.

What follows is a brief guide to help with some of the most important accessibility rules. If you are creating a more
complex web resource you should contact the UX Group [94] for a more in-depth review. 

 

  

Page Layout, Tables and Content

Organization

A sighted user of a web page can quickly scan the entire page. Someone using a screen reader will hear a linear
rendering of the page, one part at a time. Semantic markup is an important part of making the screen reader
translation meaningful. You want to insure that the flow of the page as rendered in a reader will make sense, and
present the page in a way that enables someone using a screen reader to quickly move through all the content,
choosing that content they are interested in.

Give a descriptive and informative title for the web page
Organize content with headers and lists, using semantic markup. If you use the editor tools in Libguides
and YaleSites semantic markup will be applied when you select text and then apply the appropriate header
format. Headers 1 and 2 are reserved, so your hierarchy should start with header 3.
Include the most meaningful content at the beginning of all paragraphs and links.
Provide a logical flow of text and navigation through the page.
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Provide a way to skip repeated content. The library's web site contains such a skip navigation command
automatically.
You can test your semantic markup using WAVE (web accessibility evaluation tool) [95].
A useful test for organization is to listen to your web page as it would render in a screen reader. One free
one is NVDA. You may download NVDA  [96]for free from NVAccess.

Data Tables

It is important to differentiate layout tables and data tables. Commonly you will use a table to present some
type of data. We discourage the use of layout tables as a design element.
For data tables, associate columns and rows with headers in tables. 
Include a caption for the table. When using the insert table function in the YaleSites editor you will
be prompted to enter a caption.
Keep data tables simple and avoid nested tables.

Understandable Content

Material on the library web site is generally in English. This is indicated for you automatically by YaleSites'
use of the lang attribute and you do not need to indicate the language. When a different language is
included within the page use a block attribute ( example <blockquote lang=”es”>)
Spell out an abbreviation the first time it is used.

 

These guidelines were adapted from Webaim Checklist. [97] 

  

Text Color and Size 

Provide a contrast ratio for the color of text and its background color of 4.5:1 for font sizes below 18 points.
If the font size is large (greater than 18 points) the contrast ratio should be 3:1 or more.
Provide text that is still readable when zoomed in 200%. Zoom in to this level and then shrink the page to a
very narrow width. The text should not break.
When color is used to convey meaning, a second method must also be used. For example, use a shape
and color.
Color along should not be used to identify a link.

Test the color contrast using the Web AIM Color Contrast Checker [98] or Check My Colours [99].

  

Images, Video, and Audio

Images

Make sure all images and form buttons have associated descriptive text. Screen reader technology cannot
automatically convey the meaning of an image. The ALT attribute is used for this purpose, and the creator must
provide this information. The ALT attribute information is also used when an image cannot be displayed properly. If
you wonder if you need to add information in the ALT attribute, or what information to put there, ask yourself “What
text would I provide if I did not have this image or the image was missing?” A full explanation of uses of ALT
attribute is provided by Webaim.org [100]

Describe an image with meaningful content using the ALT attribute within the IMG HTML element. Name
the item(s) in the image. Do not use the phrase “image of.” However, you may wish to specify “painting,”
“photograph” or other genre if this is important.
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As shown below, when you upload an image in Yalesites, an entry element will open prompting you to enter
the "Alternate Text." This will populate the ALT attribute.

Leave ALT attribute blank for a purely decorative image with no meaning and no link to other material. 

Video and Audio

When inserting video or audio files on your online resource you must

Provide a full text transcript of video and audio.
The transcript and video/audio should be synchronized.
Provide captions synchronized to the audio of the video, including video with no audio content (to describe
the action).
Provide means to stop, pause and adjust volume of video and audio.

These guidelines were adapted from Webaim Checklist. [97] 

  

Links

The purpose and ultimate destination of links must be clear from the text of the link itself or the link text and the text
immediately around it.

Do not use ambiguous wording such as "click here." Rather, include what the action will do, such as
"download the 2015 report."
In a single page do not provide links labeled with the same text that go to different places.

 

  

Forms
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Many of the following form accessibility guidelines are taken care of automatically when using YaleSites forms.

Put instructions at top of form.
Describe any form button using ALT attribute. For example, if a magnifying glass is used with a search box,
you might use "submit search."
Give any input a text LABEL value with a matching INPUT ID value. This is done for you in YaleSites.
The LABEL and INPUT field must be close together with little white space between (YaleSites does this). 
Group together related form elements.
Ensure that the user can page through all elements using the keyboard only (YaleSites does this).
Write informative labels on forms.
Mark required fields clearly (YaleSites uses the red asterisk).
Provide a summary of entry errors at the top of the form after submission (YaleSites does this).

Test the form by moving through it with the keyboard only (do not use the mouse). You should not get stuck in any
one element and should be able to move from one entry to the next. In YaleSites, this should not be a problem.

These guidelines were adapted from Webaim Checklist. [97] 

  

Navigation 

Ensure a user can move around to all elements of the page using only a keyboard.
Make it visually apparent where the keyboard control is at any time.
Make all page functionality available using a keyboard as alternative to the mouse.
Provide a "skip navigation" command. This is done for you in the library's YaleSites pages.

  

Accessibility Testing Resources

External Resources for Testing and Understanding Accessibility Issues

Test the color contrast on a web page to ensure that text is readable for the widest range of users: Color
Contrast Checker [98]
Test the semantic markup to ensure that the meaning of the page will render well in a screen reader: Web
Accessibility Evaluation WAVE [101]
There are browser specific tools that can aid accessibility reviews, such as the Chrome Plug Ins for
Accessibility  [102]and Firefox Accessibility Toolbar [103]. These are more useful for web developers than
editors. 
Check how your page will sound on a screen reader. Try NVAccess [96], a free screen reader. 

  

Accessibility Checklist for Editors and Content Owners

Web Pages

Using YaleSites and LibGuides as designed should ensure that your web page is accessibility. When you create a
web page using one of these resources check that 

The page title is meaningful.
Every image or form button has an ALT tag. The ALT tag should convey the meaning and content of the
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image. The exception to this rule is if the image is purely decorative, in which case do not provide an ALT
tag.
The page is divided into meaningful segments using headings 3 and 4, and bulleted or numbered lists
(applied through the page editor).
Non-English language is marked with the correct language tag.
Do not alter the color scheme of the default text and the default background color. 
Make sure color contrast is a minimum 4.5:1, or if large text (14 pt and larger) a minimum contrast ratio of
3:1.

Video/Audio

When creating a video or audio provide a synchronized transcript. 

Test the Page

Try to run through the page using only the keyboard by tabbing through the page elements. You should be
able to access every element on the page.
Try increasing text view 200% and make the page dimensions much smaller. Text should not "break" and
the display should still work. 
Run the page through the WAVE tool  [101]to identify markup problems. 
If you've changed colors, make sure that there are no color contrast issues by using a color checker such
as the WebAIM Color Contrast Checker. [98]
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Troubleshooting Questions and Answers

Q: I'm trying to access a page and see a "You do not have permission to view this page” message, even though it
is published.

A: Possibly the "theme" has not been specified. Find the Theme field and check the theme key "Yale University
Library."

Q: Can we embed an image in a page?

A: You will use Upload files / images option when you create the Basic page. See Create Basic Page [114] for
more information.

Q: How do I change to a custom alias? 

A: Change View default alias to custom alias > Using redirect from new alias to default alias

Q: My book menu has disappeared.

A: If the original book page was created as content type Basic Page, then the menu structure should be in the Book
outline.

Q: The Author block disappeared in my Collection Landing Page after changing the Author name.

A: The New Author might not have the necessary's information in the profile. Check that all fields displayed in the
author block are filled in.

Q: Orange background color for PL Search block with style " block-yul-searach" is off in "Chrome", the height
doesn't change with content

A: Change  style to "highlight-block"
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People, Groups and Permissions

Special Groups

Ask Yale Library

Created as 'No result' replacement for some Subject page (http://ask.library.yale.edu/ [115])

Medical Library

Used as the Subject Specialist for most medical subjects with link (Alternate Home to replace LibguidID) to
their Liaisons page [116]

MSSA

Used as the Subject Specialist for Yale History

Library IT

Used as Author of PL help [73]

  

Feedback Forms (not YaleSites)

These forms are stored in Qualtrics yalesurvey.qualtrics.com

Contact Us: linked from Orbis. Options for report an error in a catalog record (catalog.problems@yale.edu [117]),
account problems (askyalelibrary@yale.edu [118]), requests (askyalelibrary@yale.edu [118]), accessing digital
resources (e-resprob@mailman. yale.edu ), research question (askyalelibrary@yale.edu [118]), suggest an
improvement (libraryit@yale.edu [119]),

Feedback: linked from Findit, Quicksearch and Articles+. More general in nature. Findit goes to the Hydra list.
Summon feedback goes to Angela and Jenn Nolte.

Interlibrary Loan Satisfaction and Scan and Deliver Service Satisfaction are both used by Access Services.

Software for Collaboration: An internal library survey, no longer active, to determine what collaboration tools
were desired by staff.

  

Google Analytic Help

Configuration > System > Google Analytics > Web Property ID => UA-16198946-1
  => To be used in GTM as Variable constant gaAccount

Configuration > System > Google Tag Manager > Contained ID => GTM-KVRNCC
   *** This will track the Druple site only. http://web.library.yale.edu [120]
  *** If not see GTM, need to enable the module (Statistics > Google Tag Manager)
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For GA account user, use this tool (Account Explorer [121]) to search or browse through your accounts, properties,
and views, See what accounts you have access to, and find the IDs that you need for the API or for another tool or
service that integrates with Google Analytics.
 

References

Google Analytics at Yale [122]
Data Analytics in Library [123]
Google Analytics Help [124]
Google Analytics Academy Online Course [125] (Google Tag Manager Fundamentals, Digital Analytics
Fundamentals)
Practical Google Analytics and Google Tag Manager for developer [126]

 

    Source URL:https://web.library.yale.edu/lit/sr 

Links
[1] https://web.library.yale.edu/web-design-guidelines [2] http://yalesites.yale.edu/ [3] http://web.library.yale.edu/cas
[4] https://web.library.yale.edu/lit/sr/create-home-page [5] &#109;&#97;&#105;&#108;&#116;&#111;&#58;&#115;&#
116;&#101;&#118;&#101;&#110;&#46;&#119;&#105;&#101;&#100;&#97;&#64;&#121;&#97;&#108;&#101;&#46;&
#101;&#100;&#117; [6] https://web.library.yale.edu/arts [7] https://web.library.yale.edu/mssa [8]
https://web.library.yale.edu/music [9] https://web.library.yale.edu/divinity [10] https://web.library.yale.edu/bass-
library [11] https://web.library.yale.edu/international-collections [12] https://web.library.yale.edu/classics-library [13]
https://web.library.yale.edu/international/east-asia-library [14] https://web.library.yale.edu/testimonies [15]
https://web.library.yale.edu/music/hsr [16] https://web.library.yale.edu/lit [17]
https://web.library.yale.edu/departments/microform [18] https://web.library.yale.edu/departments/preservation [19]
https://web.library.yale.edu/development [20] https://web.library.yale.edu/digital-collections [21]
https://web.library.yale.edu/lit/sr/create-development-council-site [22] https://wordpress.org/support/topic/no-page-
menu-item [23] http://wordpress.stackexchange.com/questions/30303/how-make-top-level-menu-item-not-have-link-
but-have-sub-menus-that-are-linked [24] &#109;&#97;&#105;&#108;&#116;&#111;&#58;&#118;&#105;&#110;&#9
9;&#101;&#110;&#116;&#46;&#109;&#97;&#115;&#115;&#97;&#114;&#111;&#64;&#121;&#97;&#108;&#101;&#4
6;&#101;&#100;&#117; [25] &#109;&#97;&#105;&#108;&#116;&#111;&#58;&#107;&#105;&#109;&#98;&#101;&#1
14;&#108;&#121;&#46;&#112;&#97;&#115;&#107;&#111;&#64;&#121;&#97;&#108;&#101;&#46;&#101;&#100;&#
117; [26] http://yalesites.yale.edu/book/hiding-your-theme-other-sites [27] http://www.library.yale.edu/ [28]
http://web.library.yale.edu/ [29] http://web.library.yale.edu/admin/config/search/redirect/add?redirect=node/2949&a
mp;language=und&amp;destination=node/2949/edit [30] http://yalesites.yale.edu [31]
http://web.library.yale.edu/sites/default/files/content/images/filename.jpg%22 [32]
http://web.library.yale.edu/sites/default/files/files/filename.pdf.%C2%A0 [33] http://yalesites.yale.edu/book/wysiwyg-
toolbar [34] http://yalesites.yale.edu/book/working-content [35] http://findit.library.yale.edu [36]
https://collections.library.yale.edu/ [37] http://web.library.yale.edu/digital-collections/arabic-and-persian-medicine 
[38] http://web.library.yale.edu/digital-collections/day-missions-periodicals [39]
http://guides.library.yale.edu/content.php?pid=445257&amp;sid=4406775#16108285 [40]
http://yalesites.yale.edu/module-tutorials/webform [41] https://www.drupal.org/node/823408 [42]
https://www.drupal.org/node/1609324 [43] https://web.library.yale.edu/lit/sr/librarynews [44]
https://docs.acquia.com/dev-desktop/start/cloud [45] https://windows.github.com/ [46] mailto:you@$ [47]
https://git.yale.edu/ [48] https://git.yale.edu/netid/dev.library.yale.edu.git [49]
https://git.yale.edu/yul/dev.library.yale.edu.git [50] http://dev.library.yale.edu [51] http://yalesites.yale.edu/refresh-
my-site [52] http://yalesites.yale.edu/book/using-github-enterprise [53] http://yalesites.yale.edu/book/getting-
changes-merged-upstream [54] http://yalesites.yale.edu/book/common-git-operations [55]
https://help.github.com/articles/set-up-git/ [56] https://help.github.com/articles/create-a-repo/ [57]
https://help.github.com/articles/fork-a-repo/ [58] https://www.drupal.org/node/594744 [59]
http://services.library.yale.edu/cas [60] http://yalesites.yale.edu/book/rotating-header-image [61]
http://yalesites.yale.edu/book/add-embedded-images [62] http://web.library.yale.edu/admin/config/people/cas [63]
https://git.yale.edu/mteac/tst.library.yale.edu/blob/master/sites/all/themes/yul/css/yul-yul-default.css [64]
http://web.library.yale.edu/sites/default/files/content/images/yul_pallette_0.png [65] https://web.library.yale.edu/yul-

Page 33 of 34



Site Resources Help For Web Developers
Published on Yale University Library (https://web.library.yale.edu)

news/this-week [66] https://web.library.yale.edu/librarynews/archives/2008/12 [67]
https://web.library.yale.edu/librarynews/archives/2009 [68] https://web.library.yale.edu/librarynews [69]
http://web.library.yale.edu/nota-bene-feed [70] https://web.library.yale.edu/yul-publications [71]
http://elischolar.library.yale.edu/cgi/viewcontent.cgi?article=1075&amp;context=yul_nota_bene [72]
https://web.library.yale.edu/users [73] https://web.library.yale.edu/pl/help [74] https://web.library.yale.edu/admin/pl-
student [75] https://www.drupal.org/node/1343798 [76] http://guides.library.yale.edu/profile.php?uid=4154 [77]
http://guides.library.yale.edu/profile.php?uid=3282 [78] http://guides.library.yale.edu/profile.php?uid=58546 [79]
https://web.library.yale.edu/librarians-by-major [80] https://web.library.yale.edu/librarians-by-programs [81]
https://web.library.yale.edu/subject-specialists [82] http://oir.yale.edu/yale-factsheet#UndergraduateMajors [83]
http://guides.library.yale.edu/home [84] http://admissions.yale.edu/majors-and-academic-programs [85]
http://catalog.yale.edu/ycps/majors-in-yale-college [86] http://gsas.yale.edu/academics/departments [87]
http://catalog.yale.edu/ycps/subjects-of-instruction/ [88] http://catalog.yale.edu/ycps/subject-abbreviations/ [89]
http://web.library.yale.edu/sd/departments [90] http://web.library.yale.edu/users [91]
http://web.library.yale.edu/admin/yul-staff [92] &#109;&#97;&#105;&#108;&#116;&#111;&#58;&#115;&#116;&#101;
&#118;&#101;&#110;&#46;&#119;&#105;&#101;&#100;&#97;&#64;&#121;&#97;&#108;&#101;&#46;&#101;&#100
;&#117;?subject=Request%20for%20Building%20Content%20Type%20 [93] http://www.w3.org/TR/WCAG20/ [94] 
&#109;&#97;&#105;&#108;&#116;&#111;&#58;&#107;&#97;&#116;&#104;&#108;&#101;&#101;&#110;&#46;&#98
;&#97;&#117;&#101;&#114;&#64;&#121;&#97;&#108;&#101;&#46;&#101;&#100;&#117;?subject=Accessibility%20
questions [95] http://wave.webaim.org/report#/web.library.yale.edu [96] http://www.nvaccess.org/ [97]
http://webaim.org/standards/wcag/checklist [98] http://webaim.org/resources/contrastchecker/ [99]
http://www.checkmycolours.com/ [100] http://webaim.org/techniques/alttext/ [101] http://wave.webaim.org/ [102]
https://chrome.google.com/webstore/search/accessibility [103] https://addons.mozilla.org/En-US/firefox/addon/juicy-
studio-accessibility-too/?src=search [104] http://www.w3.org/standards/webdesign/accessibility [105]
http://webaim.org/intro/ [106]
http://www.niso.org/apps/group_public/download.php/14487/future_library_resource_discovery.pdf [107] http://www
.scopus.com/inward/record.url?eid=2-s2.0-77954005026&amp;partnerID=40&amp;md5=215f50589f40b9d3c87094
a1353dfb9a [108] http://www.scopus.com/inward/record.url?eid=2-s2.0-84866402139&amp;partnerID=40&amp;md
5=e086b274a9121d89296a624b7c727a93 [109] http://www.scopus.com/inward/record.url?eid=2-s2.0-7404914414
4&amp;partnerID=40&amp;md5=9a161cc08b2f0f79b894886e401dd1aa [110] http://learningspacetoolkit.org/needs-
assessment/working-with-data/creating-personas-workshop-tool/ [111] http://www.nngroup.com/articles/discount-
usability-20-years/ [112] http://www.nngroup.com/articles/usability-101-introduction-to-usability/ [113]
http://www.usability.gov/what-and-why/index.html  [114] http://web.library.yale.edu/lit/sr/create-basic-page [115]
http://ask.library.yale.edu/ [116] http://library.medicine.yale.edu/services/crs/liaisons [117] &#109;&#97;&#105;&#10
8;&#116;&#111;&#58;&#99;&#97;&#116;&#97;&#108;&#111;&#103;&#46;&#112;&#114;&#111;&#98;&#108;&#10
1;&#109;&#115;&#64;&#121;&#97;&#108;&#101;&#46;&#101;&#100;&#117; [118] &#109;&#97;&#105;&#108;&#1
16;&#111;&#58;&#97;&#115;&#107;&#121;&#97;&#108;&#101;&#108;&#105;&#98;&#114;&#97;&#114;&#121;&#
64;&#121;&#97;&#108;&#101;&#46;&#101;&#100;&#117; [119] &#109;&#97;&#105;&#108;&#116;&#111;&#58;&#
108;&#105;&#98;&#114;&#97;&#114;&#121;&#105;&#116;&#64;&#121;&#97;&#108;&#101;&#46;&#101;&#100;&
#117; [120] http://web.library.yale.edu [121] https://ga-dev-tools.appspot.com/account-explorer/ [122]
http://guides.library.yale.edu/ga/defs [123] https://web.library.yale.edu/ga [124] https://support.google.com/analytics
[125] https://analytics.google.com/analytics/academy/ [126] http://www.books24x7.com/marc.asp?bookid=104364

Page 34 of 34


